The following restrictions and provisions only apply to the programs referred to in this section and licensed to you. You acknowledge that the programs may contain third party software (VAR applications) licensed to Oracle. Depending upon your product and its version number, the VAR applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding any other term or condition of the agreement and this ordering document, you shall not cause or permit alteration of any VAR...
Applications. For purposes of this section, “alteration” refers to all alterations, translations, upgrades, enhancements, customizations or modifications of all or any portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-engineering or reverse engineering and recompilations or reverse compilations of the VAR Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or confidential information of the VAR Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to replace, with functional equivalent software, any of the VAR Applications in future releases of the applicable program.
Contents

Send Us Your Comments........................................................................................................................ v

Preface......................................................................................................................................................................................... ix
  Audience ........................................................................................................................................................................ ix
  Documentation Accessibility ................................................................................................................................................ ix
  Related Documents ........................................................................................................................................................ ix
  Customer Support ........................................................................................................................................................... ix
  Review Patch Documentation .......................................................................................................................................... x
  Improved Process for Oracle Retail Documentation Corrections ........................................................................................ x
  Oracle Retail Documentation on the Oracle Technology Network ............................................................................... x
  Conventions ................................................................................................................................................................. x

1 Log In and Out
  Log On to the Application ............................................................................................................................................... 1-1
  Log Out of the Application............................................................................................................................................ 1-1

2 User Help

3 Common Actions and Icons
  Task Bar Options .......................................................................................................................................................... 3-1
    Application Navigator ................................................................................................................................................ 3-2
    Favorites .................................................................................................................................................................... 3-2
    Tasks ....................................................................................................................................................................... 3-2
    Reports .................................................................................................................................................................... 3-3
  Screen Level .......................................................................................................................................................... 3-3
    View all the Sections Within a Window .................................................................................................................. 3-4
  Table Level ........................................................................................................................................................ 3-4
    Action Menu and Icons ...................................................................................................................................... 3-4
    View Menu ........................................................................................................................................................ 3-6
  Search Screens ......................................................................................................................................................... 3-6
    Search for a Deal Through the Basic Search Criteria ......................................................................................... 3-7
    Search for a Deal Through the Advanced Search Criteria ................................................................................. 3-8
    Personalize Saved Search ................................................................................................................................... 3-10
    Create Saved Search ........................................................................................................................................ 3-10
4 Set User Preferences

Regional Options ................................................................. 4-1
Language Options ................................................................. 4-1
Accessibility Options ............................................................. 4-2
Accessibility ........................................................................... 4-2
Configure Application for Screen Reader Mode ..................... 4-3
Set Accessibility to Default .................................................. 4-4

5 Download/Upload Data from Spreadsheets

Download Data ....................................................................... 5-1
Upload Data ............................................................................ 5-2

6 View Data Loading Status

Table ...................................................................................... 6-2
Table - Actions Menu and Icons ............................................ 6-2
Data Loading Status - View Menu and Icons ......................... 6-2
Data Loading Status Toolbar ................................................. 6-3

Glossary

7 Notifications

Notification Badge ................................................................. 8-1
Notification Sidebar .............................................................. 8-2
Search Bar ............................................................................ 8-2
Filtering Panel ..................................................................... 8-3
Grouping Panel ..................................................................... 8-3
Results Panel - List View .................................................... 8-4
Results Panel - Grouped View .............................................. 8-4
Results Panel - Summarized View ....................................... 8-5
All Notifications Tab ............................................................ 8-6
Send Us Your Comments

Oracle Retail Sales Audit Cloud Service Do the Basics User Guide, Release 16.0.030

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document.

Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

---

**Note:** Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the Online Documentation available on the Oracle Technology Network Web site. It contains the most current Documentation Library plus all documents revised or released recently.

---

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at [http://www.oracle.com](http://www.oracle.com).
Preface

This document describes the Oracle Retail Sales Audit Cloud Service user interface. It provides step-by-step instructions to complete most tasks that can be performed through the user interface.

Audience

This document is for users and administrators of Oracle Retail Sales Audit Cloud Service. This includes merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

For more information, see the following documents in the Oracle Other Product One Release 16.0.030 documentation set:

- Oracle Retail Sales Audit Cloud Service Release Notes
- Oracle Retail Sales Audit Auditing Transactions User Guide
- Oracle Retail Sales Audit Foundation Data User Guide

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL: https://support.oracle.com

When contacting Customer Support, please provide the following:
Review Patch Documentation

When you install the application for the first time, you install either a base release (for example, 13.1) or a later patch release (for example, 13.1.2). If you are installing the base release and additional patch releases, read the documentation for all releases that have occurred since the base release before you begin installation. Documentation for patch releases can contain critical information related to the base release, as well as information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content, Oracle Retail documentation may be republished whenever a critical correction is needed. For critical corrections, the republication of an Oracle Retail document may at times not be attached to a numbered software release; instead, the Oracle Retail document will simply be replaced on the Oracle Technology Network Web site, or, in the case of Data Models, to the applicable My Oracle Support Documentation container where they reside.

This process will prevent delays in making critical corrections available to customers. For the customer, it means that before you begin installation, you must verify that you have the most recent version of the Oracle Retail documentation set. Oracle Retail documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle part number, as well as print date (month and year). An updated version uses the same part number, with a higher-numbered suffix. For example, part number E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all previous versions.

Oracle Retail Documentation on the Oracle Technology Network

Oracle Retail product documentation is available on the following web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You can obtain these documents through My Oracle Support.)

Conventions

The following text conventions are used in this document:
<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Log In and Out

Before you can do anything in an Oracle Retail application, you must log in to the application. And when you are done, you must log out. This chapter describes these processes.

Log On to the Application

To log on to the application:

1. Click the User list menu on the top right of the Oracle Sales Audit window.

   *Figure 1–1 User List Menu*

2. Click Login. The Welcome screen appears.

   *Figure 1–2 Welcome Screen*

3. Provide the following login information:
   
a. Enter your user name in the Username field.
   
b. Enter your password in the Password field.

4. Click Login.

Log Out of the Application

Use the User list menu, which is to the top right of the Oracle Retail Sales Audit window, to log out of the application.
Figure 1–3  Logging Out of the Application
This application contains an online HTML help that can guide you through the user interface. User information is included to describe high-level processes and procedures, as well as provide step-by-step instructions for completing a task.

You can access online help for a particular page by clicking on the Help link at the top of the application home page or by clicking the Help icon 🛠️. Once in the help, you can access additional information through the table of contents or by using the index.
Oracle Retail applications, such as, Oracle Retail Sales Audit, include some common interface options and controls that you can use throughout the application workflow. The following sections describe these user interface controls in more detail.

Although you may have more than one Oracle Retail application installed on your system, each application may use many of the same interface components and abide by common rules and constraints.

The following topics are covered in this chapter:

- Task Bar Options
- Table Level

### Task Bar Options

You can quickly access the tasks of current applications and switch to other applications from the Navigation bar.

*Figure 3–1  Navigation Bar*

The following Navigation bar options are common across all the applications:

- Application Navigator
- Favorites
- Tasks
- Notifications
- Reports
Application Navigator

The Application Navigator is optional for the application and provides the ability to switch between applications.

**Note:** Your view may vary, depending upon the features selected during the setup process.

To switch between applications:

1. At the top left of the application, click the Application Navigator icon to open the list of available applications.

   ![Application Navigator](image)

2. Select the listed applications. The application will open in a new tab.

Favorites

You can select your favorite tasks without accessing the Tasks menu. It helps you quickly get into your frequently used tasks.

You can click the Favorites icon in the Tasks menu to access tasks designated as favorites. You can also select the cog icon from the Favorites menu to edit the favorite list. Tasks can be selected or deselected as favorites in the Tasks menu.

![Favorites Area](image)

Tasks

Oracle Retail applications support a variety of navigational tools and methods that allow you to move efficiently between application pages. Information on how to use and manage each of the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to accomplish a business process or procedure. For example, tasks can be defined for common multi-step procedures or processes so that you can quickly step through tasks. By navigating sequentially to the pages outlined in the task, you are assisted in stepping through the business process or activity.
Your Tasks list appears on the extreme left side of the home page. All of the tasks to which you have access appear in the list on the Tasks window. You can either click on the specific task name to open or use the Task Search component to search for a Task that you want to open.

To begin working with a task, choose the application feature or process from the list.

**Note:** Your Tasks menu may appear slightly different, depending on your retail application.

---

**Figure 3–4  Tasks Menu**

![Tasks Menu](image)

**Reports**

The functionality of Reports works similar to the Tasks menu.

**Figure 3–5  Reports**

![Reports](image)

**Screen Level**

The screen level actions display the icons and buttons.

**Figure 3–6  Screen Level Action - Icons and Buttons**

![Screen Level Action](image)
View all the Sections Within a Window

You can view all the sections in the Deal window by clicking the Expand icon. You can shrink all the sections in the Deal window by clicking the Shrink icon.

Table Level

Table 3–1  Screen Level Action - Icons/Buttons and Descriptions

<table>
<thead>
<tr>
<th>Icon/Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help icon ☰</td>
<td>You can access online help for a particular page by clicking the Help icon.</td>
</tr>
<tr>
<td>Expand and Collapse icon ☰</td>
<td>You can view all and collapse all the sections in the application window by clicking the Expand and Collapse icon.</td>
</tr>
<tr>
<td>Delete icon ✗</td>
<td>You can delete a component by selecting the Delete icon.</td>
</tr>
<tr>
<td>Status Action Button</td>
<td>Depending on the status of your record, the status action button displays. For example, Submit. Wherever applicable, this button will be available to change the status of an entity. The status will be changed to the label specified on the button. If there is more than one status to which the entity can be changed, clicking the arrow on the right side of the button will display the additional status options.</td>
</tr>
<tr>
<td>More Actions</td>
<td>The More Actions button will have any additional actions and options for navigating to other screens.</td>
</tr>
<tr>
<td>Save</td>
<td>Click Save to save the entered records.</td>
</tr>
<tr>
<td>Save and Close</td>
<td>Click Save and Close to save the records and exit the window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click Cancel to reject your entries and exit the window.</td>
</tr>
</tbody>
</table>

Note:

- Figure 3–7, Figure 3–8, Figure 3–9 are mere representation and may be different for every window/table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For more information on these options, see the sections Action Menu and Icons and View Menu.

Action Menu and Icons

The Actions menu provides the option to take different actions related to entries in the table. Depending on the nature of the table, these actions can be add, view, delete or edit table rows, create by moving to a new screen or export the table contents to the spreadsheet. Alternatively these actions can also be performed by using the icon buttons on the table toolbar. For more information on the icon/buttons, see the Screen Level.

In some tables, it may also contain some table specific actions.
**Table 3–2  Actions Menu/Icons and Descriptions of Components Section**

<table>
<thead>
<tr>
<th>Actions Menu/Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add and Add icon ✈️ | You can add a component by clicking **Add** from the Actions menu or by clicking the Add icon ✈️.  
For more information on adding a component, see “To Add an Item to a Transaction” in the *Oracle Retail Sales Audit Cloud Service Auditing Transactions User Guide*. |
| Edit and Edit icon ✏️ | You can edit a component by clicking **Edit** from the Actions menu or by clicking the Edit icon ✏️.  
For more information on editing a component, see “Edit Totals” in the *Oracle Retail Sales Audit Cloud Service Foundation Data User Guide*. |
| Delete and Delete icon ✗ | You can delete a component by clicking **Delete** from the Actions menu or by clicking the Delete icon ✗.  
For more information on deleting a component, see “Deleting a Bank ACH Transaction Amount” in the *Oracle Retail Sales Audit Cloud Service Auditing Transactions User Guide*. |
| Export to Excel icon 📑 | You can save the table to a Microsoft Excel spreadsheet by clicking the Export to Excel option from the Actions menu or by clicking the Export to Excel icon 📑. |
| Wrap icon 🧪 | You can wrap the values in the table column by using the Wrap icon 🧪 option. |

**Table 3–3  Actions Menu/Icons and Descriptions of Audit Rule Search**

<table>
<thead>
<tr>
<th>Actions Menu/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and Create icon 📌</td>
<td>You can create an audit rule by clicking <strong>Create</strong> from the Actions menu or by clicking the Create icon 📌.</td>
</tr>
<tr>
<td>Edit and Edit icon ✏️</td>
<td>You can edit an audit rule by clicking <strong>Edit</strong> from the Actions menu or clicking the Edit icon ✏️.</td>
</tr>
</tbody>
</table>
View Menu

The View menu provides the options for managing the table columns and sorting and filtering the table data.

In some tables you have the option to choose a saved custom view, which is an arrangement of columns different from the default view of the table.

**Figure 3–9 View Menu of Components Section**

<table>
<thead>
<tr>
<th>View Menu List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>You can manage which of the columns will be shown in the table by clicking the <strong>Show All</strong> and <strong>Manage Columns</strong> options.</td>
</tr>
<tr>
<td>Detach</td>
<td>You can view the tables in the application in a separate window by clicking Detach or by clicking the Detach icon.</td>
</tr>
<tr>
<td>Sort</td>
<td>You can sort columns by the following options:</td>
</tr>
<tr>
<td></td>
<td>◾ Ascending</td>
</tr>
<tr>
<td></td>
<td>◾ Descending</td>
</tr>
<tr>
<td></td>
<td>◾ Advanced</td>
</tr>
<tr>
<td>Reorder Columns</td>
<td>You can reorder columns by clicking the Reorder Columns option.</td>
</tr>
<tr>
<td>Query by Example</td>
<td>You can filter components by one of multiple column values by clicking the Query by Example option or by clicking the query by example icon.</td>
</tr>
</tbody>
</table>

Search Screens

You can search for a particular entity by entering, selecting, or searching in the Merchandising Operations Management (MOM) application, for example to search for a deal.

To search for a deal:
1. From the Tasks menu, select Orders > Deals > Manage Deal. The Deal Search window appears.

2. You can search for a deal by providing search criteria in the search section. The criteria can be provided either in Basic or Advanced mode, depending on the requirement. Basic is the default mode when the search screen is entered. Click Advanced to access the search panel in advanced mode. You can return to Basic mode by clicking Basic.

Search for a Deal Through the Basic Search Criteria

To search for a deal through the basic search criteria:

1. Enter or select one or all of the following basic search criteria.

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deal</td>
<td>Enter the deal ID.</td>
</tr>
<tr>
<td>Deal Type</td>
<td>Select the deal type. The options are: Annual, Promotional, PO Specific, and Vendor Funded Markdown.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the deal. The options are: Worksheet, Submitted, Approved, Rejected, Closed.</td>
</tr>
<tr>
<td>Billing Type</td>
<td>Select the type of deal being created. The options are: Off invoice, Bill Back, Bill Back Rebate, Vendor Funded Promotion, Vendor Funded Markdown.</td>
</tr>
<tr>
<td>Vendor Type</td>
<td>Select the vendor type.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Enter, select or search for the vendor.</td>
</tr>
<tr>
<td>Active Date</td>
<td>Enter the date on which the deal becomes active, or click the calendar icon and select the date.</td>
</tr>
<tr>
<td>Close Date</td>
<td>Enter the date on which the deal ends, or click the calendar icon and select the date.</td>
</tr>
</tbody>
</table>

2. You can also click on the Saved Search drop down to select one of the saved sets of search criteria. Selecting a saved search will populate the criteria section with saved criteria. If the saved search is selected to run automatically then the search will be executed too. You can also choose to manage and personalize the saved searches by clicking Personalize in the list. The Personalize Saved Searches window appears. For more information on the Personalize Saved Searches, see the section Personalize Saved Search.

3. Click Search. The deals that match the search criteria are displayed in the Results section.
4. Click Reset to execute the saved search.

5. Click the Save.. button to save the current set of search criteria as a Saved Search. The Create Saved Search window appears. For information on the Create Saved Search window, see the section Create Saved Search.

6. Click Done to close the window.

Search for a Deal Through the Advanced Search Criteria

To search for a deal through the advanced search criteria:

1. Enter or select one or all of the following advanced search criteria.

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deal</td>
<td>Enter the deal ID.</td>
</tr>
<tr>
<td>Deal Type</td>
<td>Select the deal type.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the deal.</td>
</tr>
<tr>
<td>Billing Type</td>
<td>Select the type of deal being created.</td>
</tr>
<tr>
<td>Vendor Type</td>
<td>Select the vendor type.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Enter, select or search for the vendor.</td>
</tr>
<tr>
<td>Active Date</td>
<td>Enter the date on which the deal becomes active, or click the calendar icon and select the date.</td>
</tr>
<tr>
<td>Close Date</td>
<td>Enter the date on which the deal ends, or click the calendar icon and select the date.</td>
</tr>
<tr>
<td>External Ref. No.</td>
<td>Enter the external reference number.</td>
</tr>
<tr>
<td>Order No.</td>
<td>Enter, select or search for the order number.</td>
</tr>
</tbody>
</table>
2. You can also click the **Saved Search** drop down to select one of the saved sets of search criteria. Selecting a saved search will populate the criteria section with saved criteria. If the saved search is selected to run automatically then the search will be executed too. You can also choose to manage and personalize the saved criteria.
searches by clicking Personalize in the list. The Personalize Saved Searches window appears. For more information on the Personalize Saved Searches, see the section Personalize Saved Search.

3. Click Search. The deals that match the search criteria are displayed in the Results section.

4. Click the Save.. button to save the current set of search criteria as a Saved Search. The Create Saved Search window appears. For information on the Create Saved Search window, see the section Create Saved Search.

5. Click Done to close the window.

**Personalize Saved Search**

Select Personalize from the Saved Search list to view the personalized saved search. The Personalize Saved Searches pop up allows you to edit, copy, or delete Saved Searches.

![Personalize Saved Searches Window](image)

**Create Saved Search**

You can create a Saved Search by selecting the Save button in the Search Criteria panel after you have entered the criteria for your search. The Save button will call up the Create Saved Search window where the search is given a name and the user determines whether it should be the default search as well as whether it should be run automatically.

To view the created saved search:

1. Click the Save.. button. The Create Saved Search window appears.

![Create Saved Search Window](image)

2. Enter the name of the search.

3. You can also choose to save the combination of the search criteria by selecting the following check boxes:
- Set as default
- Run automatically
The Preferences pages are where you specify the default regional, language, and accessibility settings that you want to use throughout the system.

To set your preferred preferences, click **user name > Preferences** at the top of the application home page. The Preferences page appears. The standard preference options available are as follows:

- Regional
- Language
- Accessibility

To return to the application home page, click **Back to Home** at the top of the page. The Preferences pages are where you specify the default regional, language, and accessibility settings that you want to use throughout the system.

### Regional Options

Use the following options to specify the default formats for territory, date, time, number, and time zone you want to use throughout the system.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Territory</td>
<td>Specify the country details.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Select the date format that you want to use.</td>
</tr>
<tr>
<td>Time Format</td>
<td>Select the time format that you want to use.</td>
</tr>
<tr>
<td>Number Format</td>
<td>Select the number format that you want to use.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone you want to use.</td>
</tr>
</tbody>
</table>

### Language Options

Use the following options to specify the default language you want to use throughout the system.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Specify the default language you want to use.</td>
</tr>
<tr>
<td>Current Session</td>
<td>Specify the language you want to use for the current session.</td>
</tr>
</tbody>
</table>
Accessibility Options

Use the following options to specify the default accessibility preferences you want to use throughout the system.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessibility</td>
<td>Select the accessibility option you want applied.</td>
</tr>
<tr>
<td>Color Contrast</td>
<td>Specify the color contrast that you want to use.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Specify the font size that you want to use.</td>
</tr>
</tbody>
</table>

Accessibility

Accessibility involves making your application usable for differently abled persons such as low vision or blindness, deafness, or other physical limitations. This means creating applications that can be used without a mouse (keyboard only), used with a screen reader for blind or low-vision users, and used without reliance on sound, color, or animation and timing.

The Merchandising Foundation Cloud Service solutions provides the ability for users to switch between accessibility support levels in the application, so that users can choose their desired type of accessibility support, if required. They do so by exposing a user preferences screen in which the user can specify the accessibility preferences/mode which will allow the user to operate in that mode.

- Default Mode: By default, the Merchandising Foundation Cloud Service solutions have rich user interface interaction, and are also accessible through the keyboard. Note that in the default mode, screen readers cannot access all components. If a visually impaired user is using a screen reader, it is recommended to use the Screen Reader mode.

- Screen Reader: Merchandising Foundation Cloud Service solutions are optimized for use with screen readers. The Screen Reader mode facilitates the display for visually impaired users, but will degrade the display for sighted users (without visual impairment).

Additional fine-grained accessibility levels as described below are also supported:

- High-contrast: Merchandising Foundation Cloud Service solutions can display high-contrast-friendly visual content. High-contrast mode is intended to make the solutions compatible with operating systems or browsers that have high-contrast features enabled. For example, they change its use of background images and background colors in high-contrast mode to prevent the loss of visual information. Note that the Merchandising Foundation Cloud Service solutions high-contrast mode is more beneficial if used in conjunction with your browser’s or operating system’s high-contrast mode. Also, some users might find it beneficial to use large-font mode along with high-contrast mode.

- Large-fonts: Merchandising Foundation Cloud Service solutions also support browser-zoom-friendly content. In default mode, most text and many containers have a fixed font size to provide a consistent and defined look. In large-font mode, text and containers have a scalable font size. This allows the solutions both to be compatible with browsers that are set to larger font sizes and to work with browser-zoom capabilities. Note that if you are not using large-font mode or browser-zoom capabilities, you should disable large-font mode. Some users might also find it beneficial to use high-contrast mode along with the large-font mode.
Merchandising Foundation Cloud Service/Sales Audit Cloud Service provides the ability to switch between the above accessibility support levels in the application, so that users can choose their desired type of accessibility support, if required. It exposes a user preferences screen in which the user can specify the accessibility preferences/mode which will allow the user to operate in that mode.

**Configure Application for Screen Reader Mode**

Users can configure their session to the accessibility mode by setting user references on the home page of the application as shown below. Perform the following procedure to configure a user preference for screen reader mode.

1. Log into one of the Merchandising Foundation Cloud Service solutions. In this example, we use Merchandising Foundation Cloud Service.
2. From the application home page, select Preferences from the logged in user menu.

   ![Logged-in User Menu](image1)

3. From the Tasks pane, click Accessibility to open the Accessibility tab.

   ![Accessibility Tab](image2)

4. Select Screen Reader to enable accessibility mode, and click Save.

Set User Preferences  4-3
5. Click on Back to Home to return to the home page. Now the application is enabled in the screen reader mode to assist a visibly challenged user. Some of the graphical content of Operational Insights is also displayed in a tabular mode.

Set Accessibility to Default

Perform the following procedure to set Accessibility mode to Default mode.

1. From the application home page, select Preferences from the logged in user menu.

2. From the Tasks pane, click Accessibility to open the Accessibility tab.
3. Select Default mode.

4. Click Save to save the settings.

5. Click Back to Home to return to the home page. Application is returned to default mode and you can view graphical reports.
ReSA allows the setup and configuration of a set of standard templates which allow you to upload and update data using spreadsheets. These spreadsheets can be uploaded to the system using the Upload Data window.

The following process is followed to update data for the above ReSA modules:

1. Download the spreadsheet template for the module you want to update using the Download Data window.
2. Make the updates in the spreadsheet.
3. Upload the data using the Upload Data window.

**Download Data**

To download data as spreadsheets:

1. From the Tasks menu, select **Foundation Data > Data Loading > Download Data**. The Download Data window appears.
2. In the **Template Type** field, select the type of template. The following template types are available:
   - Error Codes
   - GL Cross Reference
   - Reference Fields
   - Currency Rounding Rules
   - Store Data
   - Tender Types
   - Constants
3. In the **Template** field, select the template you want to download.
Upload Data

To upload data using spreadsheets:

1. From the Tasks menu, select Foundation Data > Data Loading > Upload Data. The Upload Data window appears.

2. In the Template Type field, select the type of template.
   The following template types are available:
   - Error Codes
   - Reference Field
   - Currency Rounding Rules
   - GL Cross Reference
   - Store Data
   - Tender Types
   - Constants

3. In the Template field, select the template of the spreadsheet.

Figure 5–2  Upload Data Window for a Template Upload into ReSA
4. Enter a process name in the **Process Name** field. The value specified in this field enables you to find the process created to identify the status of the upload and view any errors that were identified.

5. Select the spreadsheet to be uploaded in the **Source File** field.

6. Click **Upload**. The relevant data corresponding to the template is uploaded into the spreadsheet file specified.
The Data Loading Status window allows you to view the status of the upload and download processes happening in RMS, so that you can rectify the issues associated with the upload/download process.

The window allows you to drill down to the errors or warnings associated with a selected upload/download request.

You can access the Data Loading Status window from the Task menu, select **Foundation Data > Data Loading > Review Status**. The Data Loading Status window appears.

The Data Loading Status window contains the following sections.

- **Table**
- **Data Loading Status Toolbar**

*Figure 6–1  Data Loading Status Window*
Table

The table displays the process, process description, file name, template category and type, destination, action date and time, status and the user, who initiated the process.

Table - Actions Menu and Icons

Use the Actions Menu and icons to apply actions to the table. You can perform the actions listed below.

<table>
<thead>
<tr>
<th>Actions Menu/Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete and Delete icon ✗</td>
<td>You can delete a process by using the following steps:</td>
</tr>
<tr>
<td></td>
<td>■ Select a record in the table.</td>
</tr>
<tr>
<td></td>
<td>■ Select Actions &gt; Delete or use the Delete icon ✗.</td>
</tr>
<tr>
<td></td>
<td>■ You are prompted, if you want to delete the record. Select Yes to confirm the prompt.</td>
</tr>
<tr>
<td></td>
<td>■ The record is deleted from the table.</td>
</tr>
<tr>
<td>Export to Excel and Export to Excel icon 📊</td>
<td>You can export the records in the table to a Microsoft Excel spreadsheet by selecting Actions &gt; Export to Excel or by using the Export to Excel icon 📊.</td>
</tr>
<tr>
<td>View Issues and View Issues button</td>
<td>To view the warnings and errors associated with a selected upload/download request:</td>
</tr>
<tr>
<td></td>
<td>■ Select a record in the table.</td>
</tr>
<tr>
<td></td>
<td>■ Select Actions &gt; View Issues or use the View Issues button. The Issues window appears.</td>
</tr>
<tr>
<td></td>
<td>■ Click Done to close the window.</td>
</tr>
<tr>
<td>Upload to RMS</td>
<td>With this option you can upload the selected process from Staging to RMS.</td>
</tr>
<tr>
<td></td>
<td>This option is only enabled for records which have Staging Tables as a destination and do not hold the status “Processed with Errors”. Additionally, this option is only enabled for Item induction, Cost Change induction and Order induction records.</td>
</tr>
<tr>
<td>Download Staged</td>
<td>This option allows you to download the staged records of a process to a spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>■ Select a record in the table.</td>
</tr>
<tr>
<td></td>
<td>■ Select Actions &gt; Download Staged. The staged record are downloaded to your desktop.</td>
</tr>
<tr>
<td></td>
<td>This option is only enabled for Item induction, Cost Change induction and Order induction records.</td>
</tr>
</tbody>
</table>

Data Loading Status - View Menu and Icons

You can customize the view of the table by using the options in the View Menu.

<table>
<thead>
<tr>
<th>View Menu/Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>You can manage which of the columns will be shown in the table by clicking the Show All and Manage Columns options.</td>
</tr>
<tr>
<td>Detach and Detach icon 📊</td>
<td>You can view the table in the application in a separate window by clicking Detach or by using the Detach icon 📊.</td>
</tr>
</tbody>
</table>
Data Loading Status Toolbar

The toolbar contains the following icons and buttons.

<table>
<thead>
<tr>
<th>Table 6–3 Data Loading Status Toolbar - Icons/Buttons and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Icons/Buttons</strong></td>
</tr>
<tr>
<td>Help icon</td>
</tr>
<tr>
<td>Refresh icon</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save and Close</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
<tr>
<td>Done</td>
</tr>
</tbody>
</table>
audit rules
Audit rules allow you to set your own sales data validation criteria.

business day
A business day is a calendar day except for the retailers running 24x7 operations. The retailers who operate 24 hours a day and seven days a week may have their Store Day spread to more than one calendar day. ReSA uses the Day Close transactions from the POS application to define the close of business day.

errors
Errors arise when the conditions of a rule definition are not met. You can either correct these errors or you can override them.

error impact
Errors arising out of the transaction data validation performed by ReSA may have impact on the export of data to the external systems. At times, the data should not be exported to the external systems until the error is corrected. At other times, the impact of the error may be very negligible and limited only to the internal ReSA application. In such situations, the data can be exported to external systems.

escheatment
Escheatment is the process of forwarding money of outstanding, non-expiring vouchers to the proper governing authorities after a defined period of time from the date of issuance.

The Escheatment functionality in ReSA is driven by the hierarchy of Store, Issuer, Recipient, and HQ. When performing escheatment, ReSA checks to determine whether there is an address for the first level of the hierarchy, the Store. If so, it checks if the state or country is defined in the Escheatment table in ReSA. If the state or country exists on the table, it then checks to determine whether the Store indicator for that state or country is set to yes. If so, ReSA escheats the money to that state or country. If no state or country exists for the store, or one does but does not exist on the Escheatment table, or it does exist on the table but the Store indicator is set to no, then ReSA checks the next level, Issuer, and so on. If no matches are found after ReSA checks all four levels of the hierarchy, then the retailer claims the voucher as income.

full disclosure
A method of restating data by sending a negation of the entire first statement, then a second complete statement.
**overriding errors**

There are some errors that cannot be corrected. For such errors, you need to acknowledge the error and then override these errors.

**report data**

Allows you to generate reports, such as, the Flash Sales Report and the Flash Totals Report.

**ReSA status**

ReSA maintains status at three different levels, store status, data status, and audit status. The status associated with Stores level indicates the status of the store, like worksheet, fuel closed and closed. The status associated with Data level indicates the progress of data upload, like ready to load, loading, partially loaded, fully loaded, and purging. The status associated with Audit level indicates whether the sales data is audited, or is in the process of auditing, or if errors were identified at the store or headquarter for correction.

**revision**

Revision is an archive of updates made to transactions. Before updating the current data in transaction tables, a snapshot of the data is maintained as revisions to historical data. This process includes the following steps:

- Creating a new version of the transaction record.
- Keeping the older version of the record unchanged.
- Moving the older version of the transaction record to a revision table.

Moving the older version to a separate version history table maintains a complete audit trail and also minimizes the amount of data held in main transaction tables.

**rules definition**

By providing a Rule Definition in the ReSA system, you are actually defining the conditions that the ReSA system should meet to perform an additional level of transaction data validation.

**sales audit**

Sales audit is essentially the process of reviewing the point-of-sale transaction data for accuracy.

**store day**

A store day is the time spent between opening cash registers at the start of a calendar day and closing the registers at the end of the day. For some retailers, a store day spans over more than one calendar day.

**totals**

A total is a summation or count of two or more entities. For example, a total can be a summation of the quantity of items sold in the store on a particular store day.

Totals are captured in the POS or OMS system and imported into ReSA. For example, summation of the quantity of items sold in a store during a particular store day. Totals are used to perform store balancing, perform analysis within the ReSA system to control losses, generate reports, and to export audited data to external systems. Totals can either be defined in ReSA or imported as reported by POS or OMS.
**total definition**
By providing a Total Definition in the ReSA system, you are actually defining from where the total values will come into the ReSA system.

**total level**
Total level indicates the level at which the totals are calculated. The total level relates to the balancing level that is chosen for the system.

**total values**
This refers to the actual numeric value produced when the Total Definition is run against the transaction data.

**transaction**
A transaction is a record of events at a location, which may include sale, return, and exchange of items. The following is an illustration of the list of attributes that a transaction record may contain:
- Date and time of transaction
- Salesperson ID
- Register number
- Cashier
- Invoice number
- Item details
- Item quantity
- Item taxes
- Discounts
- Transactional taxes
- Tender details
- Customer details
- Paid out details
Notifications bring events within the application to your attention. See the following examples:

- A simple, informative message indicating a long-running process has completed
- A message indicating a critical exception has occurred
- The store create request failed

**Figure 7-1 Notifications**

![Notification Badge Image]

### Notification Badge

The Notification Badge displays the number of unread notifications for the user in the sidebar menu. The Notification Badge displays ’99+’, when there are more than 99 notifications.

The notification count is periodically refreshed at regular intervals. This interval is determined by a system-configured value.
Notification Sidebar

When you click the Notification icon, the Notifications Sidebar is shown displaying the most recent set of unread notifications (depending on the filter set).

Each component of the Notifications Sidebar is discussed in detail in the following sections:

Search Bar

A search bar at the top of the panel allows for searching through notifications. The search bar has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the Notification results to be displayed either in a flat or grouped view.
Figure 7–4 Search Bar

Filtering Panel

The Filtering Panel allows you to filter notifications based on Creation time, Severity and Type.

The values for the Time Periods and Severity components are pre-seeded constants. The Type drop-down lists all the notification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the Results Panel.

Figure 7–5 Filtering Panel

Grouping Panel

This panel allows you to group notifications based on different attributes.

The values of the ‘Group by’ and the ‘Then by’ components are pre-seeded.
Results Panel - List View

When no selection is made in the Grouping Panel, the Results Panel displays notifications in a list format.

The image below shows a simple search without any filtering or grouping.

Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results Panel, when the Group By drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.
**Results Panel - Summarized View**

Notifications are summarized as shown in this example, when both the Group By and the Then By drop-downs in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the selections on the Grouping Panel. For each subgroup, a count of the notifications within that subgroup, grouped by severity is displayed.

The example below depicts a grouping by department, then by class.

---

**Figure 7–9 Results Panel - Summarized View**

1. Indicates that both options on the Grouping Panel have been selected.

2. First level of grouping is by Department. Here the first department shown is ‘dept1’. 
3. The subgroup within department ‘dept1’. In this example, this is the Class name.
4. The number of notifications within that combination of Group and Subgroup.
5. A grouping by severity of all notifications within that combination of Group and Subgroup.
6. The timestamp of the most recent notification of that combination of Group and Subgroup.

All Notifications Tab

The All Notifications tab is shown when you click the ‘See All’ link at the bottom of the Notifications side panel.

Figure 7–10 All Notifications

This tab lists all the Notifications for the logged-in user, regardless of whether they are in Read or Unread status. Information tiles display a break-up of the total notifications by severity. Clicking these tiles refreshes the table below to display only those notifications that are relevant to that tile.

You can perform the following operations from this tab.

- **Delete** - The table allows for multiple selection and hence multiple notifications can be deleted at a time. Use the row header to select the row.
- **Refresh** - This refreshes the list of notifications in the table.
- **Mark as Read** - Multiple Unread Notifications can be marked as Read by clicking this button.
■ Mark as Unread - Multiple Read Notifications can be marked as Unread by clicking this button.

■ Reassign Notifications - Notifications can be reassigned to individual recipients or a group by clicking the Reassign Notifications icon. On selecting a row in the All Notifications table, and clicking the icon, the reassign notification popup is displayed. The Type is set to Reassigned by default, and the Severity and Description are pre-populated from the selected row; you can then change any of these values and assign the notification to one or more recipients.

**Figure 7–11 Reassign Notification**

The All Notifications table displays the following columns:

■ Notification Severity - A colored label indicating the Notification Severity.

■ Status - If the status is unread, an icon is shown. Otherwise it is blank.

■ Description - The description of the notification itself.

■ Type - The description of the Notification Type for the notification.

■ Recipients - In case of individual notifications, this column contains the user ID of the user to whom the notification is assigned. When the notification is assigned to multiple users, it displays the text ‘Multiple’ and enables a context popup which lists all the recipients. This field is empty when the notification is assigned to a group associated with a type.

■ Creation Date - Timestamp showing the date and time of creation.

■ Created By - User ID of the user who created the notification.

■ Last Updated Date - Timestamp showing the date and time when the last update was made.

■ Last Updated By - User ID of the user who last updated the notification.

■ Application ID - Unique identifier that identifies the application. Not visible by default.

■ Department - The Department associated with the notification. Not visible by default.

■ Class - The Class associated with the notification. Not visible by default.

■ Subclass - The Subclass associated with the notification. Not visible by default.
- Location - The Location associated with the notification. Not visible by default.
- Supplier - The Supplier associated with the notification. Not visible by default.
- Performance - The Performance value associated with the notification. Not visible by default.
- Brand - The Brand associated with the notification. Not visible by default.
- Rollup Count - The Rollup Count associated with the notification. Not visible by default.
- Additional Information - Refers to the Additional Information attribute associated with the notification. Not visible by default.